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Introduction

Acon Digital Media EffectChainer is a free DirectX and VST capable universal wrapper and

multi-effect rack. With EffectChainer you can load, edit and chain as many DirectX and VST

plug-ins you want. EffectChainer itself can be used as a plug-in in any host application supporting

DirectX or VST.

Feel free to contact support@acondigital.com if you encounter bugs in / or problems with

EffectChainer.

Please also visit the Acon Digital Media website to get to know more interesting audio software:

http://www.acondigital.com

VST is a trademark of Steinberg Media Technologies GmbH
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Features
· Universal wrapper and multi-effect rack 

· Use DirectX plug-ins in applications supporting only VST plug-ins 

· Use VST plug-ins in applications supporting only DirectX plug-ins

· Can be used from DirectX and VST compatible host applications Supports VST and DirectX

plug-ins - you can load as much plug-ins your computer can handle 

· Processes audio successively by all loaded and active effects 
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· Supports mono and stereo inputs / outputs 

· Easy to use interface providing access to all features (effect menu, options menu, mute / solo

functions, drag & drop to change effect order, editor access) 

· Effect editor including complete parameter and program (VST) / preset (DirectX) handling 

· Possibility to save and load chains in the Acon Effect Chain file format, the common VST

program / bank system or as static presets (DirectX version) 

· Share effect chain files across different applications
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System Requirements
Before you install EffectChainer, please make sure your computer fulfills the

following requirements:

· A Pentium or compatible processor with a CPU clock rate of 500 MHz or more

· A minimum of 128 megabytes RAM

· A Windows-compatible sound card

Depending on the number of plug-ins you have loaded to EffectChainer, the requirements,

especially the CPU clock rate, can be considerably higher.

In addition, you will need the following software installed on your computer:

· Windows 2000, Windows XP or Windows Vista

· DirectX 8.0 or later (the current version at the time this is written is DirectX 9.0c)

· A DirectX or VST plug-in compatible host application
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Installation
To install EffectChainer on your System simply run the setup file "EffectChainer10Xus.exe" and

follow the instructions. You can use it directly after installation without restarting your system.

The DirectX version of EffectChainer will be shown as "Acon Digital Media EffectChainer" in the

plug-in list of your host application.

The VST version is named "EffectChainer.dll" and located in the VST folder you have chosen

during installation. It appears as "EffectChainer", "EffectChainer.dll" or "Acon EffectChainer" in

your host. If you need the "EffectChainer.dll" in a different folder, just copy it to the designated

target.

When you run EffectChainer for the first time, it asks you to scan all available plug-ins on your

system. The VST path is set by default to the VST directory you have chosen. In case you use

another directory just change the VST path in the options menu and perform a new scan.
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User Interface
All functions of EffectChainer can be accessed within the effect list window. The right mouse

button opens the options menu. The remaining functions can be controlled with the left mouse

button. A highlight effect indicates the positions where interaction is possible.
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1: empty effect container

2: effect type symbol (DirectX or VST)

3: effect name

4: mute button

5: solo button

6: edit button

 

5.1

 

The Effect Menu

You can open the effect menu by pressing the left mouse button while you hover onto an empty

effect container or the effect name of a loaded effect. The effect menu is used to add or remove an

effect.
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5.1.1

 

Add an Effect

You can use the plug-in lists in "DirectX" or "VST" to load an effect to EffectChainer. In these lists

you can find all valid scanned plug-ins on your system. Please note that you have to perform a

new scan manually if you have installed new plug-ins. The "Recent Plugins" list contains the last

ten effects you have loaded. The "Select VST..." function makes it possible to load a VST effect

from any location of your System via a file-open dialog box.

After you have added a new plug-in successfully to the effect list, it is shown in a new effect

container marked with the effect type symbol on the left and the effect name. Loading a plug-in in

an existing effect container replaces the existing one.

 

5.1.2

 

Remove an Effect

With "Remove Effect" you can delete a plug-in from the effect list. So all subsequent plug-ins will

be moved one position to the top.

 

5.2

 

The Options Menu

 

5.2.1

 

Close Editors

All opened effect editors will be closed at once.

 

5.2.2

 

Clear List

Removes all plug-ins out of the effect list.

 

5.2.3

 

Rescan DirectX Plug-ins

Scans the system for valid DirectX plug-ins and makes them available in the "DirectX" list. 

EffectChainer only supports stereo DirectX plug-ins.



 

5

 

EffectChainer Help

 

© 2007 Acon Digital Media

 

5.2.4

 

Manage VST Folders

Opens a dialog box to specify the VST folders you use.

Add Folder: You can add a folder from your system to the list via a browse-dialog. After this you

can perform an initial scan on this directory. 

Remove Selected: Deletes the selected folders from the list (multiple selection is possible). The

plug-ins within the removed folder(s) are also not longer available in the "VST" plug-ins list.

Rescan Selected: Performs a new scan in all selected folders and updates the "VST" plug-ins list

(multiple selection is possible).

 

5.2.5

 

Save Chain

You can save the current effect list including all plug-in states via a file-save dialog box in the

AconEffectChain file format (*.aec).

 

5.2.6

 

Load Chain

A previous saved effect chain in the *.aec file format can be restored via a file-open dialog box.

 

5.2.7

 

Select Font

Opens a font dialog where you can select the font-style and font-size which are used to display the

effect name.

 

5.2.8

 

Toggle I/O-Warnings

Disables or enables the warning messages that are shown e.g. when you load a VST plug-in which

supports only mono inputs.
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5.3

 

Work with Effects

 

5.3.1

 

Move an Effect

To change the position of an effect in the list just use the drag&drop function accessible at the

effect type symbol. A white effect container frame helps to find the new position. The effect where

you release the mouse button swaps the position with the one you dragged in the effect list.

 

5.3.2

 

Mute and Solo Functions

You can activate / deactivate a plug-in with the mute button. While an effect is muted (red colored

button), audio data is not processed by it.

The solo button mutes all plug-ins except of the selected one. When you have activated the solo

function you can not use any mute button until you deactivate solo. After deactivating solo the

originally mute states of the plug-ins in the list will be restored.

 

5.3.3

 

Edit an Effect

Via the edit button you can open the effect editor of the respective plug-in. It is possible to open

and use several or all editors at the same time.

The title of the editor window shows the index of the plug-in in the effect list as well as the name

of the effect and the current chosen program (VST) or preset (DirectX).
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In case a plug-in does not have a custom editor (only VST effects) the standard editor will be

loaded.

To adjust the effect settings, the standard editor offers a slider for each parameter of the plug-in.

As an additional feature you can open an edit box to enter a value directly by pressing the left

mouse button in the text right of the slider. Depending on the values used by this parameter and

also to keep the average access time fast, it is possible that in some cases only an approximated

value or none result can be found. For string values like "-oo" or "LOW" can be searched too.

 

5.3.3.1

 

Program / Preset Handling

The menu in the effect editor provides all functions to load and edit programs (VST) or presets

(DirectX).

In a VST plug-in you can save or load a single program or the whole bank (all programs) with the

corresponding functions in the menu. With "Rename Program..." you can change the name of the

current program.

DirectX plug-ins use the "User-Presets Manager..." to save or restore an effect's state. Presets you

have added in this way appear with the prefix "[User]" in the menu list.
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5.3.3.2

 

Effect Information

VST effects can open an Info box that shows some information about the plug-in.It can be accessed

via the menu function "? - Effect Info...".
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Processing Information
Here you can find some details how processing takes place in EffectChainer:

· Muted effects are excluded from processing.

· Solo mutes all other effects except of the selected one.

· In case a VST effect supports only mono output, the audio data will be duplicated by 

EffectChainer.
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· If a VST effect supports only mono inputs or does not have any inputs or outputs you will lose

stereo information or complete audio data.

· When you use EffectChainer in the VST version, it is not intended to apply DirectX plug-ins, that

change the block size during processing like time scale modification plug-ins. Indeed you can

load, edit and process them this will probably lead to corruption of the audio signal, because

bigger blocks will be cut off and smaller blocks filled up with zeros. The DirectX version of 

EffectChainer can handle these kind of plug-ins clean.

· EffectChainer counts the delay of all loaded an active VST plugins in the list. This value is

updated and transmitted to the host every time right before playback starts (VST version)!

Consider this if you need a correct delay compensation.



 

Index

 

10

 

© 2007 Acon Digital Media

 

Index

 

- * -

 

*.aec

 

5

 

- A -

 

Acon Digital Media

 

1

 

AconEffectChain File Format

 

5

 

Add an Effect

 

4

 

Add DirectX

 

4

 

Add VST

 

4

 

Add VST Folder

 

5

 

- B -

 

Bank

 

7

 

- C -

 

Clear List

 

4

 

Close Editors

 

4

 

Custom Editor

 

6

 

- D -

 

Delay Compensation

 

8

 

Drag&Drop

 

6

 

- E -

 

Edit an Effect

 

6

 

Edit Button

 

2

 

Editor

 

6

 

Effect Container

 

2

 

Effect Editor

 

6

 

Effect Info

 

8

 

Effect List

 

2

 

Effect Menu

 

3

 

Effect Name

 

2

 

Effect Type Symbol

 

2

 

- F -

 

Features

 

1

 

Font

 

5

 

Font Dialog

 

5

 

Font Size

 

5

 

Font Style

 

5

 

- I -

 

Information

 

8

 

Installation

 

2

 

Introduction

 

1

 

- L -

 

Load Bank

 

7

 

Load Chain

 

5

 

Load Program

 

7

 

Load VST

 

4

 

- M -

 

Manage VST Folders

 

5

 

Move an Effect

 

6

 

Mute

 

6

 

Mute Button

 

2

 

- O -

 

Options Menu

 

4

 

- P -

 

Presets

 

7

 

Processing

 

8

 

Programs

 

7

 

- R -

 

Recent Plug-ins

 

4

 

Remove Effect

 

4

 

Remove VST Folder

 

5

 

Rename Program

 

7

 

Requirements

 

2

 

Rescan

 

4, 5

 

Rescan DirectX Plug-ins

 

4

 

Rescan VST Folder

 

5

 

- S -

 

Save Bank

 

7

 

Save Chain

 

5

 

Save Program

 

7

 

Select Font

 

5

 

Solo

 

6

 

Solo Button

 

2

 

Standard Editor

 

6

 

Static Presets

 

7

 

Support

 

1



 

EffectChainer Help

 

11

 

© 2007 Acon Digital Media

 

System Requirements

 

2

 

- T -

 

Toggle I/O Warnings

 

5

 

- U -

 

User Interface

 

2

 

User Presets

 

7

 

- W -

 

Warnings

 

5

 

Website

 

1


	Introduction
	Features
	System Requirements
	Installation
	User Interface
	The Effect Menu
	Add an Effect
	Remove an Effect

	The Options Menu
	Close Editors
	Clear List
	Rescan DirectX Plug-ins
	Manage VST Folders
	Save Chain
	Load Chain
	Select Font
	Toggle I/O-Warnings

	Work with Effects
	Move an Effect
	Mute and Solo Functions
	Edit an Effect
	Program / Preset Handling
	Effect Information



	Processing Information

